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Contacts

CSU SGS Field Station Addresses:

North Side

SGS LTER Headquarters
14791 Weld County Rd. 114
Nunn, Colorado 80648
970-897-2210

LTER Field Research Staff

Mark Lindquist, Site Manager
970-897-2210 (North Side HQ)
970-213-9576 (cell)
970-897-2217 (North Side house)
970-897-2276 (South Side R&IC)
Mark.Lindquist@colostate.edu

LTER Administrative Staff

Sallie Sprague, Project Manager
970-491-2366 (campus)

NESB A311 (office: 9 am-3pm M-F)

Sallie.Sprague@colostate.edu

Carolyn Schultz, Administrative Assistant

970-491-4996 (campus)

NESB A317 (office: 11:30-3:30 M,W)

Carolyn.Schultz@colostate.edu

Nicole Kaplan, Information Manager

970-491-1147 (campus)
970-416-7726 (home)

NESB A315
Nicole.Kaplan@colostate.edu

Bob Flynn, IT/GIS
970-491-6832 (campus)
Shepardson 7 (office: after 1 pm)
Robert.Flynn@colostate.edu

Other Important Numbers

Field Crew Cell Phone: 970-213-9646

South Side

SGS Research & Interpretive Center (R&IC)
14698 Weld County Rd. 114

Nunn, CO 80648

970-897-2276

Mary Ashby, ARS-CPER Site Manager: 970-897-2226
CSU Motor Pool: 970-491-0116, 491-0172, or 491-0016 (Sandy Gilbert)

SGS Web Page

http://sgslter.colostate.edu

For agency and emergency numbers, see page 23 of this document.
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Campus Headqguarters

Administrative offices of the SGS-LTER Project Manager and Administrative Assistant are located on the 3"
floor of the Natural and Environmental Sciences Building (NESB), rooms A311 and A317. SGS-LTER project
posters, staff mailboxes, FAX, photocopier and power point projector are available for use.

Information Management and IT/GIS staff are located in both NESB A315 and the SGS-LTER satellite offices
in the basement of the Shepardson building, room 7. Archived materials, computer laboratory and a small
conference area are located in Shepardson.

Various laboratory facilities are available on campus through SGS-LTER and the Natural Resources Ecology
Laboratory (NREL). Special arrangements need to be made for use. Contact Sallie Sprague for information.



Information Technology

Mapping a network drive to the LTER server

**You must first request a ‘user’ or ‘project’ folder from Nicole Kaplan or Bob Flynn. Criteria and
rules for user and project folders are described on the following pages.**

You must have Windows 2000, XP, or Vista as your operating system in order to access the ASCALON
server (Mac users, please contact Bob Flynn at 491-6832). Follow these steps to map to Ascalon:

Open Windows Explorer Select Tools>Map Network Drive, or right click on My Computer and
select Map Network Drive.

In the Map network drive dialogue box enter these values:

Drive: (enter any letter drive, preferably one you can keep using)

Folder: \\ascalon.cas.colostate.edu\lter
Reconnect at Logon: (You can check this box if you wish and the computer will
prompt you for your elD username and password to automatically map to ascalon
when you first logon to your computer.)

Click Connect using a different username and enter these values in the dialogue box:

Username: colostate\eidname
Password: eidpassword

Where eidname is your CSU EID username (for example ssprague, not sallie.sprague)
and eidpassword is your CSU EID password

Click OK and then Einish

In Windows Explorer you will now see on this mapped drive two main subfolders, “users” and “projects”. Click
the “users” folder and you will see all user folders including yours.

(Here's an explanation for the extra work in case you are interested...
We are now working within the university domain, so we need to use our elD username and password. In addition, we
need to indicate that our username is part of the CSU domain that's why we need to type colostate\ before our username.)

Rules for using the LTER server

1. All users must follow the acceptable uses for computing and networking at CSU. This policy can be
found at http://www.colostate.edu/Services/acns/aup.html.

2. Do not read or copy files from other people’s directories without permission.

3. Only work on LTER related data may be stored on the server. Please check your home department for
back- up of non-Iter files.

Permissions to access directories and files on the SGS Server

All lter users are part of a general group of users that has permission to navigate through every directory, and
read and copy files inside. Thus, be aware that the default settings allow any other user to read and copy files in
your user folder, but not edit them. We suggest that you store confidential correspondence, strategic planning
documents, financial disclosures, and personal files off the server. The lter database and file organization has
been managed this way in the past and we have never had a problem. The benefit is that information managers
and staff that are part of the Iter group, may find data and information to work with, even when a Pl is away
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from his or her office. The original files are protected because other users may only copy a file, not alter it. In
addition, other users may not paste a file into your directory. If necessary, you can alter the default protection
settings on files and folders to prevent other users from reading or copying them. Call your IM staff to show you
how to make these changes (Nicole, 491-1147 or, Bob 491-6832).

Server Organization
The LTER work areas on ASCALON are divided into 2 categories. One area supports the work of individual

USERS, where each Iter user has his or her own directory. The other area contains directories that organize and
store information for PROJECTS, which a few users may access and work on together as a group.

Guidelines for USER directories

SGG-LTER On-Line Database

Data delivery steps:
o Researcher and IM transforms data into standardized
format and submits data & metadata to sgs-Iter database

USERS * GIS manager transfers study site information and any
spatial data to the GIS Library
A 4 ¢ IM & Researcher discuss data acquisition policy

o Final products, such as citations to publications, data
BETTY and metadata are archived to become searchable and
accessible on the sgs-Iter website

/ \  Final maps and other attributes may be served on the
sgs-Iter map server

* EML is exported from database and harvested to

DEVELOPMENT: FINAL
Network-wide metacat

A\ 4

Work directly on A\ 4

k:\\ascalon\ Iter\users\betty Final Products

Organize directories and files to
complete your lter related work
only.

—‘>  Thesis/dissertation/publication

o Tables and Figures

by

o Posters and Presentations e Abstracts e Publications

Supporting Data
» Organize by chapter or publication

* Data (ASCII Format) » Metadata

Images

Spreadsheets, databases

Programs ¢ SAS, models, macros

¢ % v by

GIS * coverages used in analysis




Guidelines for PROJECT directories

» Communicate with your group members to establish a naming convention for files. File names should reflect
the date and site from which the data are collected. Example: 5b052803.dat

The data contained in this data file were collected from site 5b on May 28, 2003.

« Communicate with your group members to establish rules for version control. Example: cr21x_program.dld is
the program you used when you installed the data logger in 2002. Then, you had to reprogram the data logger
because you added some new equipment, but you want to keep track of the old program to correspond with
older data. So, save the new program as cr21x_program2.dld. OR You have a grant proposal that is being
edited by group members. Met_equip_nek1.doc was then edited by Bob, so the new file should be named
met_equip_bob2.doc. The final file that is submitted should reflect that in the file name, met_equipf.doc.

» Create journals or logs using Microsoft Notepad or WordPad. In the digital journal, keep track of equipment
problems and calibrations, changes in protocols, etc.

* Create separate folders for data and programs. Organize data by year, as shown from an example on the
Ascalon server:

Projects

STD MET

Datalogger Download
Program

* This is a good place to share files with your colleagues, instead of attempting to send large files over e-mail.

LTER Data Access Policy
The SGS-LTER follows the LTER Data Access Policy to categorize access to data:

1) There are two types of data: Type | (data that is freely available within 2-3 years of processing) with
minimum restrictions regarding its use by others and, Type Il (Exceptional data sets that are available
only with written permission from the Pl/investigator(s)). Implied in this timetable, is the assumption
that some data sets require more effort to get on-line and that no "blanket policy" is going to cover all
data sets at all sites. However, each site would pursue getting all of their data on-line in the most
expedient fashion possible.

2) The number of data sets that are assigned TYPE Il status should be rare in occurrence and that the
justification for exceptions must be well documented and approved by the lead Pl and site data
manager. Some examples of Type Il data may include: locations of rare or endangered species, data
that are covered by copyright laws (e.g. TM and/or SPOT satellite data) or some types of census data
involving human subjects.

Please use the following tag line in reports or manuscripts when using data from the SGS-LTER: Data
sets were provided by the Shortgrass Steppe Long Term Ecological Research group, a partnership
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between Colorado State University, United States Department of Agriculture, Agricultural Research
Service, and the U.S. Forest Service Pawnee National Grassland. Significant funding for these data
was provided by the National Science Foundation Long Term Ecological Research program (NSF
Grant Number DEB-0823405).

Field Headquarters (SGS-LTER)

The facilities on the Shortgrass Steppe are expanding. The existing SGS-LTER buildings lie to the
north of WCR 114. The facilities to the south of WCR 114 comprise the Shortgrass Steppe Research
and Interpretive Center (R&IC). They include a classroom/meeting room and two housing units. As
of this writing the South Side facilities are available for limited use. Potable water is NOT yet
available at the R&IC. The on-line version of this information booklet will be updated when the South
Side facilities are in full operation. See http://sgslter.colostate.edu/visitors.aspx for additional visitor
information.

Facilities and their use: North Side

Our facilities are shared by all researchers, however, the SGS-LTER Field Crew has priority for facilities during
the field season. Notify the Site Manager before any visitors are scheduled to arrive. Visitors, please leave
emergency contact information with the Site Manager upon your arrival. No pets are allowed at the field
station. Please leave our facilities in the same, or better, condition than you found them.

Dormitory
There are six rooms, each with sink, heater, up to three beds, small dresser, and suite bathrooms (shower &
toilet). If you plan to stay in the dorms you need to schedule your stay and check out keys with Mark Lindquist
(970-897-2210). Bring your own linens, or fitted sheet and sleeping bag.
Residents are expected to maintain their dorm area while they are on site:

Keep the bathroom clean and stocked with paper goods.

Remove trash weekly.

Make sure door is completely closed at night or when the room is unoccupied.

Sweep and mop floors weekly.

Quiet time at the station is from 10 pm to 7 am.

Replace light bulbs with 60 watt or less.

Kitchen
A fully-equipped kitchen in the main building contains a stove/oven, microwave, pots/pans, dishes and
refrigerator. Cleaning supplies are located in the kitchen closet. Visitors-in-residence are responsible for the
propane supply. Instructions are located next to the propane tank. Talk with Mark Lindquist for assistance.
The kitchen is a shared facility. Please respect the instructions below so that all residents are able to use the
kitchen during their visit.:
Immediately wash, dry and put dishes away after each use.
Keep counters, stove, microwave, refrigerator, and toaster clean.
Sweep and mop floors weekly.
Frequently take the trash out to the dumpster.
Keep kitchen door locked over night.
Keep food and cooking utensils out of the way.
Recycle weekly!
Replenish propane supply.
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Conference Room
The conference area in the main building contains tables, chairs, black board and projection screen. It has a
capacity of approximately 40. There are two adjacent restrooms. Restock with paper products when needed.

Laboratory
Sinks, bench space, drying oven, balance and other miscellaneous equipment is available. Contact the Site
Manager to arrange for their use. A first aid kit is located in the lab.

Users of the Conference Room, Computer Room and Laboratory should plan to share the following tasks:
Sweep and mop floors weekly.

Weekly remove the trash from the cans around the station.

Wipe off counter and table tops when necessary.

Keep bathrooms clean and re-stock with paper goods.

Computer Lab  ***THE LAB IS NOT AVAILABLE DURING CONVECTIVE STORMS!***
Adjacent to the conference room, the computer lab contains four computers with internet access via Internet
Explorer and access to CSU e-mail accounts. Major software includes Microsoft Word XP, Access XP, Outlook
XP, Photo Editor 3.0, PowerPoint XP, Publisher 2000, Excel XP and Adobe Acrobat 3.01. You may map a
network drive to the SGS-LTER server as if you were on campus (see page 5). The server provides a
centralized location for your files. Files on the computers in the field station lab are not backed up with the
exception of this folder on the CPER20 computer: C:\Data\Field Work Data\CRITICAL_DATA. Save your
data here if you wish it to be backed up nightly.

TURN ALL COMPUTERS OFF DURING CONVECTIVE STORMS, i.e., WITH LIGHTENING.

Respect the working space of the SGS-LTER field crew and graduate students. They have priority over use of
the computers and any reference materials. Take turns using the computers and limit yourself to ten minutes.
Do not download any material under any circumstances. Do not move any cables or alter configuration
of computers, printer, router or wireless hub. To log on to the computer:

Usename: sgslter
Password: pawnee

Instructions for Hardwire Connections

1. Open your local area network settings as
follows:

Click Start>Control Panel>Network Settings

Double Click Local Area Connections

2. Click the General Tab and Double Click
Internet Protocol (TCP/IP)

3. Inthe properties dialog click these options

Obtain an IP Address Automatically
Obtain DNS server automatically

Instructions for Wireless Connections

1. Open your wireless network settings as
follows:

Click Start>Control Panel>Network Settings

Double Click Wireless Network Connections

2. Click View Wireless Networks

3. Double Click sgslter network box

4. Enter this network key (and in confirm box
too):

16AB845E0C (Note the 0 is numeric zero)
5. Click Connect

You should be connected now. NOTE YOU
WILL ONLY NEED TO RUN THE ABOVE

STEPS ONCE. Afterwards your wireless will
connect automatically.



Instructions for Connecting to HP Color Printer

Go to Printer/Fax Connections (Start>ControlPanel>Printers/Faxes).

Select Add a Printer on left side.

In dialog box select Next then select Network Printer or Printer attached to another Computer.
Click Next.

Select Connect to this Printer and enter:

agrwdE

\\cper23\HP Officejet 5600 series

6. Select Next then Accept driver installation and click OK to make default if desired.
7. Click Finish.
8. Printer will be listed as HP Officejet 5600 series on CPER 23 on your computer.

Library

The library area contains a small collection of field guides, archived reports and other information.
Permission from the site manager is required for use of maps, books, field guides, or publications. Please
handle materials with care and keep cabinets closed.

Reference Collection
The reference collection consists of plants, small mammal study skins, bones, scat, dental impressions, insects,
reptiles, amphibians and slides. A dissecting microscope, plant presses and boards for pinning insects are
available.
Contact the Site Manager for access to these items. Please treat them gently so they will be available in the
future.

Tools and equipment
Some tools and equipment are available; check them out from the Site Manager.

Garage
Located between the main building and dormitories, the garage has limited space for work and storage. Do not
park in front of the garage or dumpsters.

Please contact the Site Manager before storing samples in the garage.

Telecommunications
The telephone is for local calls only. Use a calling card or your cell phone for long distance calls.

Mail and packages

The site address may be used to receive letters and parcels. Items are delivered to the site mailbox that is not
close to the station. Mail will be collected and brought to the field station by the Site Manager. Please let him
know ahead of time about any anticipated packages, particularly non-postal service items that may arrive at
times other than the normal daily delivery. Please ask friends and family to stop mailing items well before you
leave the station so items don’t arrive after you depart, or give the Nunn post office forwarding information.

Parking
Please park to the east of the office. Spaces immediately adjacent to the buildings are limited and used for
loading and unloading and short term parking. Do not park in front of dumpster or garage doors.

Facilities and their use: South Side (SGS Research & Interpretive Center)

A classroom/meeting room is available to accommodate 100 participants.
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Two housing units have been completed. Each has a kitchen, bedrooms, baths and small gathering areas. A
third unit should be under construction soon.

Initially, these new buildings will not have any computers available for general use. However, wireless
access and direct ethernet high-speed connections are available in the buildings for those who have
their own notebooks or other mobile computers. In the future, we expect to have desktop and notebook
computers available for researches and visitors.

Instructions for Wireless Connections (from any building on the southside.)
1. Open your wireless network settings as follows:
Click Start>Control Panel>Network Settings
Double Click Wireless Network Connections
2. Click View Wireless Networks
3. Double Click sgslter network box
4. Enter this network key (and in confirm box too):
gopher_hole
5. Click Connect

You should be connected now. NOTE YOU WILL ONLY NEED TO RUN THE ABOVE STEPS
ONCE. Afterwards your wireless will connect automatically.

Site Use Policies

ARS regulations for all non-US citizens visiting or working at the CPER

Agricultural Research Service (ARS) requires that information on all non-US citizens coming to their facilities
be collected and maintained for review. Therefore, ALL non-US citizens visiting or working with the Shortgrass
Steppe Long-Term Ecological Research (SGS-LTER) on the Central Plains Experimental Range (CPER) must
follow certain procedures regarding their presence. There are no exceptions. Whether you are a visitor or a
worker will be defined by your length of stay.

VISITORS are defined as any non-U.S. citizen spending less than 10 days on the CPER, whether going to SGS-
LTER headquarters and/or any research plots, and s/he must sign a registry at the SGS-LTER headquarters
EACH TIME upon arrival and departure. For any visitor staying in the SGS-LTER field site dormitories, the
registry must be signed each time that person leaves the CPER and returns.

WORKERS are defined as anyone spending more than 10 days on the CPER, whether working or touring, and
need to have documentation submitted BEFORE actually arriving on the CPER. All non-US citizen workers
must fill out the current Non-Citizen’s Data Sheet (ARS 230) as completely as possible and email to Sallie
Sprague (Sallie.Sprague@colostate.edu) prior to arrival in Colorado. Since the form is under revision, non-
citizens should contact Sallie well before their planned visit to the SGS-LTER and the CPER to receive a copy
of the most current version. Sallie must submit this form to the ARS at least 45 but not more than 90
BUSINESS days prior to arrival on the CPER; 45 business days is about NINE weeks prior to arrival.

Once at Colorado State University, and prior to “working” on the CPER, please make an appointment with
Sallie Sprague (970-491-2366) to bring Visa, Passport or Green Card., 1-94 or any other supporting
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documentation regarding entrance into the U.S. to her office, A311 Natural and Environmental Sciences
Building, Colorado State University. Additional information will be added to the electronic file previously sent.
The ARS 230 form will then be submitted to the appropriate ARS personnel. An amended ARS 230 will need to
be provided anytime any information changes or the worker’s status changes, i.e. leaves the CPER, etc.

The requirement for the visitor registry and the worker ARS 230 is a mandate of the USDA-ARS Office of
Homeland Security. Failure to comply will result in non-citizens being unable to work/visit the CPER.
If you have any questions, please contact Sallie.Sprague@colostate.edu.

CPER protocols

Research project approval
ARS requires submission and approval of a proposed research description prior to the initiation of new
experiments on the CPER. Forms are found at:

http://sgslter.colostate.edu/ars

Please contact the ARS Site Manager for any questions regarding the approval process:
Mary Ashby
970-897-2226
Mary.Ashby@ars.usda.gov

Prior to traveling to the CPER
Site Managers must be notified whenever you visit the site!

Contact both Mark Lindquist (LTER Site Manager, 970-897-2210, Mark.Lindquist@colostate.edu) and Mary
Ashby (ARS Site Manager, 970-897-2226, Mary.Ashby@ars.usda.gov), with destination, approximate departure
and return times and description of the vehicle you will be driving.

As a safety precaution, e-mail your destination, approximate departure and return times, and cell phone number
to your immediate supervisor and Sallie Sprague (Sallie.Sprague@colostate.edu) before you leave campus.
This is of great help to you and us in the event you need to be located for emergencies.

Greater PNG Protocols

Research project approval
The Forest Service is presently compiling research authorization forms, similar to those required by ARS for
work on the CPER. Before initiating a project on the greater PNG, you must contact the Forest Service:

Beth Humphrey

USDA-FS Pawnee National Grasslands
660 “O” Street

Greeley, CO 80631
ehumphrey@fs.fed.us

970-346-5000

Prior to traveling to the PNG

Contact Beth Humphrey (ehumphrey@fs.fed.us), if you plan to drive on secondary roads (not county roads) or
traverse the site on foot, with date you will visit the site, a description of the vehicle you will be driving and
your approximate destinations.
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As a safety precaution, e-mail your destination, approximate departure and return times, and cell phone number
to your immediate supervisor and Sallie Sprague (Sallie.Sprague@colostate.edu) before you leave campus.
This is of great help to you and us in the event you need to be located for emergencies.

If you are planning on using an LTER vehicle, use the reservation system at
http://www.sgslter.colostate.edu/vehicle_reservations.aspx.

Off-road usage

If you are planning on driving off the county roads onto any secondary PNG road, you must first obtain
permission. Driving off 2-track roads is not permitted, except in pre-approved instances. See pages 20 and 21
for specific ARS and FS guidelines.

Cell phone coverage

For safety reasons, please consider carrying a cell phone. Be aware that coverage is limited, particularly on the
eastern PNG. ATT Cingular and Verizon have comparable coverage; Sprint has no coverage in the Briggsdale
area. There is no coverage whatsoever in the Grover area. (coverage information as of 3/06) Coverage may be
better at the top of a rise, as opposed to a lower landscape position.

Fuel stops
There are two gas stations in Ault and three in Wellington. Please fill vehicles when gas gauge shows
the tank is half full. See page 16 for addresses.

The only gas station between Ault and Sterling is in Briggsdale (AgLand, 38657 Highway 14), and it is not
always open! Please plan accordingly! The station accepts the university fuel card, but only at one pump. If
you’re not certain which pump to use, check with the station attendant.

Sampling/collecting protocols

Soil: Ground disturbances larger than 1 m? require an archaeological survey and other permits which may take
several months to obtain. Permission must be obtained to sample using the probe truck (hydraulic sampling
device), even though the surface disturbance is small, because it is used off-road.

Rock, Minerals, Fossils: Rock, mineral and fossil collecting on USFS lands requires a permit. Although
collecting for personal use is allowed in most districts and permitting is usually free, collecting rules may vary.

Antiquities: The American Antiquities Act (1906) prohibits the removal or destruction of archaeological sites or
objects without a permit. Please do not remove arrowheads, chipping debris, etc. or disturb any feature that may
be a fire ring, etc.

Flora: Permission may be required prior to collection of plant material. Contact the appropriate Site Manager.

Fauna: Permits are required for all animals, including dead carcasses and feathers from endangered bird species.
A scientific collection license may be issued for temporary or permanent possession of wildlife. Applicants
must apply on forms provided by the Division of Wildlife at least 30 days prior to the anticipated need for such
a permit. See http://wildlife.state.co.us/RulesRegs/Regulations/. For bird work, permits are required by both the
DOW and US Fish & Wildlife Service. See http://www.fws.gov/permits/.

Miscellaneous
Keep a road map with you at all times and be able to communicate your location to emergency responders.

Implement “Leave no Trace” practices. Prepare for emergencies, dispose of waste properly, leave what you
find, minimize your impacts.
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Leave gates how you find them. Do not block their access.

Vehicle Management

Driving directions to CPER from CSU

SGS-LTER Field Station

14791 Weld County Rd. 114

Nunn, Colorado 80648

(Drive time: 45 minutes; Distance: 45 km)

1. North (left) on College Ave. out of the University

2. East (right) on Mulberry

3. Take 125 North towards Cheyenne, WY

4. Take Wellington Exit

5. Turn right at stop sign and make second left onto 1-25 frontage road, immediately after
interstate on-ramp

6. Make next right (east) onto Nunn Rd, (also Larimer County Rd 64 and Weld County Rd 100)

7. Continue for approx. 11 miles to stop sign in Nunn and turn North (left)

8. Continue North on Highway 85 for approx. 7 miles

9. Turn East (right) on Weld County Rd 114, at entrance of ARS/USDA Central Plains
Experimental Range (large wooden sign)

10. The station is about .75 miles east of intersection of WCR 114 and Highway 85 on your left
(north side of the road.)

WCR 37

I?l 6 Sf

12 7 8
10 11 2

15 14 13 18 17

21 | 22 23 | 24 § 19 20

LTER
WCR 114 28

27 26 | 25 30 | 29

34

31 |32

CPER Pastures
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Summary policies for vehicle use

How the public views state vehicles
IMAGE IS EVERYTHING! Know exactly where you are. Make sure that where you drive and park is a
place that you have permission to be and represents good judgment, in general.

Citizen complaints, as well as other agencies’ complaints, have been received regarding State vehicles being
driven improperly. These complaints may result in a disciplinary action to the driver by SGS-LTER. State
drivers should also be concerned about the reflection of State employees and State vehicles as perceived by the
public. Because drivers represent the State of Colorado, it is extremely important that they represent a good
image. Bad feedback may result in vehicle resource requirements being more stringently applied. State vehicles
are highly visible and represent a valuable resource. Be sure that where you drive is a place that you have
permission to be.

Use of state vehicles

Familiarize yourself with the vehicle you will be using. Check the glove compartment to see that the SGS-
LTER log book, a map of the Grasslands, flashlight, the vehicle’s registration, the Wright Express gas credit
card, the sheet listing gas stations and PIN number, the yellow roadside assistance card, the accident report
information, and the Colorado State University Fleet Vehicle User’s Guide (the last page is the Proof of
Insurance) are all there. The manual specific to that vehicle will give information about how to change a tire or
check the oil, for example. A fire extinguisher, first aid kit, and wheel block are located behind the seat.

As the operator of a State vehicle, the driver is responsible for its proper use, service, and protection and must be
familiar with the following guidelines:

Purpose for use: State vehicles are to be used for official State business only and may not be used for personal
errands including transporting family members or pets. State vehicles may not be loaned to or driven by any
unauthorized individual.

Driver’s license: Driver must possess a valid U.S. driver’s license for the class of vehicle operated.
(Responsibility for making this determination rests with SGS-LTER.)

Fuel cards: Report lost, damaged or stolen fuel cards immediately.
Seat belts: Seat belts must be worn by drivers and all passengers in a State vehicle.

Cleaning fee: A $25-$50 cleaning fee will be assessed to vehicles that do not comply with the following clean
interior policy:

1. No smoking.

2. No alcohol or drugs in any form, or anyone under the influence.

3. Remove all trash, personal items, excessive mud, seeds, plant material, etc.
4. No pets.

Keys: Drivers must pay directly for expenses to open a locked vehicle.

Portable audio devices, including cell phones: Colorado State University does not allow earphones or
headphones of any type to be worn by a person operating a University owned vehicle. Listening to portable

15



audio devices (including cell phones) while driving, through ear or headphones, is illegal while driving a
University vehicle.

Cell phones

It is highly recommended that all persons working alone on the CPER/Pawnee carry a cell phone for safety and
emergencies. Plug the cell phone in, turn it on, and check periodically throughout the day for missed calls and
attempt to return those calls (but not while driving a University vehicle). KNOW YOUR LOCATION.

Fuel cards and types of fuel

Cards are assigned to the vehicle, not the driver. At the pump, enter PIN number and the odometer reading.
NOTE: The fuel card is not to be used for any product or service not sold at the fuel pump island. (Washes, oil,
washer fluid are okay. Tires, alignments, engine repair, body repairs, general merchandise, food, etc., are NOT
allowable.) Drivers must use self-service, regular grade gasoline. Premium grades and full-service fuel may
not be purchased by the driver.

Fuel locations near the PNG:

Ault Conoco, Ault CO

970-834-1373

Monday — Saturday 5:00 AM — 10:00 PM
Sunday 6:00 AM — 10:00 PM

Ken’s Convenience, Ault CO

201 S US Highway 85

970-834-1581

Monday — Saturday 7:00 AM — 10:00 PM
Sunday 7:00 AM - 9:00 PM

Agland, Inc., Briggsdale CO
970-656-3412
Does not keep regular hours!

Loaf ‘n’ Jug, Wellington, CO
8211 6" St.

970-568-3778

Open 24 hours

Schrader’s Country Store, Wellington, CO
3700 Cleveland Ave.

970-568-3252

Monday — Friday 5 AM — 10 PM
Saturday and Sunday 6 AM — 10 PM

Shell, Wellington, CO

8214 6™ St.

970-568-7200

Every day 5:30 AM — 10 PM

Daily care of the vehicle

Drivers are responsible for the day-to-day care of vehicles. After each use, clean trash out of the vehicle and
dispose of it properly. Wind on the Pawnee presents many challenges, including the potential for damaging
vehicle doors. You must either hold the vehicle doors firmly when opening them in the wind, or park your
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vehicle facing into the wind to prevent damage to the vehicle doors. Report immediately and/all damage, dings,
scraps, windshield cracks, etc., to Mark Lindquist.

No State employee is expected to drive a vehicle that is unsafe or to ignore an unsafe condition. Follow the
advice listed below to keep your vehicle in a safe, operable condition.

Fluids: Check oil and fluids DAILY. Fill as necessary but have your vehicle checked if you are low on engine
oil, automatic transmission or power steering fluid, brake or clutch fluid or engine coolant. In order to prevent
freeze-up, do not add plain water to the radiator, coolant reservoir or windshield washer container.

Leaks: Look on the ground under the vehicle for fluid leaks. Report any leakage immediately to Mark
Lindquist.

Tires: Visually inspect the tires daily. Look for imbedded nails, check regularly for uneven wear and for proper
air pressure. Correct air pressure is the major contributor to extended tire life. Recommended tire pressure is
usually found on the driver’s door post.

Flats: Drivers are responsible for replacing a flat tire with the spare. DO NOT drive the vehicle with a flat tire
as it will ruin the tire and/or the rim. A working vehicle has 5 functional tires. You need to make sure the flat
tire is repaired by Howard’s Auto Repair. Tire repairs are preauthorized by CSU Transportation Services and
can be fixed immediately. All other repairs require an authorization (see first paragraph under BREAKDOWNS
AND REPAIRS). Please notify motor pool (970-491-0175) when you do have a tire repaired. Be prepared to
give Howard’s and motor pool the vehicle plate number and odometer reading. This information is needed for
Howard’s to be paid for the tire repair.

Howard’s Auto Repair, Pierce CO
970-834-2733

Hours: Monday-Friday 8:00 AM —5:00 PM
Saturday 8:00 AM — 12:00 noon

Towing Service

Damage: Check the vehicle before driving for body damage. Report any damage promptly (see procedures and
definition of an accident in the Accident section)

Improper use: Do not drive your truck or sport utility through rivers, creeks or streams that will exceed the
limits of your vehicle. Do not drive sedans on four-wheel drive roads. Drivers and/or SGS-LTER are
responsible for the full amount of any damage caused by improper use of their vehicle.

Lights: Check exterior lights and turn signals regularly for proper operation.

Noises: Be alert for unusual noises that could signal mechanical problems. Report immediately to Mark
Lindquist.

Gauges: If the temperature gauge reads abnormally hot, the oil pressure gauge reads low, or the red critical
Engine Light is “on”, STOP THE VEHICLE IMMEDIATELY.

If the amber caution light (check/service engine light, power loss light or emissions light) in late model vehicles
is “ON”, it indicates a potential problem. Have the vehicle checked as soon as possible. Notify Mark Lindquist.

Breakdowns and repairs

If mechanical problems are experienced while on a trip, Transportation Services must be called to obtain
authorization for repairs or towing (970-491-0103 or 970-491-0175 during normal business hours 7:00 AM —
4:00 PM). All information on how to report vehicle problems can be found in the Transportation Services
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booklet in the blue packet of every vehicle. There is also a section on after-hours emergency repairs
(evenings and weekends).

No assistance will be given for locking keys in vehicle, running out of fuel, or flat tires. The driver is
responsible for these situations.

If the vehicle must be left unattended until assistance arrives, be sure that the vehicle is clear of traffic, windows
are rolled up, doors are locked and the keys and credit cards are in the driver’s possession.

Accident information
This information is also located in the Fleet Vehicle User’s Guide in glove box of every CSU vehicle.
Please read before any action is taken!

An accident is described as ANY incident that may have caused damage to a Colorado State
University vehicle, or caused damage to private property. Accident damage includes damage
caused by another vehicle, road hazard, wildlife, weather (wind, rain, hail, etc.), vandals (this
includes glass, tires, body damage, stolen vehicles, etc.) Stolen vehicles must be reported
immediately. If you are in doubt, please call Transportation Services at 970-491-0103 or 970-491-
0116.

A. ACCIDENT PROCEDURES

At the scene of an accident involving a State vehicle, the driver must:
1. Stop immediately and aid any injured persons.
2. NOTIFY THE LOCAL POLICE by calling 911. If the local police will not send an officer to
the sceneg, file a counter report at the local police station or State Patrol station.
3. DO NOT leave the scene or move the vehicle until the law enforcement agency has
completed its investigation or until they have asked you to move it.
4. If vehicles create a definite hazard, please mark the location of each vehicle involved, then
move the vehicle.
5. CALL YOUR SUPERVISOR.
6. DO NOT ADMIT FAULT OR MAKE COMMITMENTS. DO NOT GIVE STATEMENTS
TO ANYONE EXCEPT THE POLICE OR YOUR SUPERVISOR.
7. Present the State of Colorado Insurance Card (located on back page of Colorado State
University Fleet Vehicle User’s Guide).
8. Write down ALL information required on the other driver: name; address; drivers license
number and state; expiration date, date of birth; home and work phone numbers; vehicle
owner’s name and address; year, make, model and license of vehicle; insurance company and
policy number; injured parties name(s); witnesses names, addresses and phone numbers; write
notes concerning the accident. These notes will help when you complete the accident report.
9. TOWING — DO NOT ATTEMPT TO DRIVE AN UNSAFE VEHICLE OR A VEHICLE
WITH FLUID LEAKS.

a. In the Fort Collins area, call Choice City Towing at 482-0159. Have the vehicle towed to

Transportation Services, 201 W. Pitkin Street.
b. Outside of the Fort Collins area, see the quick reference section for a list of vendors.

DO NOT HAVE THE VEHICLE TAKEN TO ABODY SHOP OR INSURANCE
COMPANY! The State driver must call Transportation Services Maintenance Assistance
section the same day or the next business day to give location of the vehicle and potential
storage charge. If this is not done, the storage charges will be the responsibility of SGS-LTER.

B. REPORTING AN ACCIDENT TO TRANSPORTATION SERVICES
1. Call Risk Management at 970-491-1432 immediately, if the accident involved serious injury
and/or damage to OTHER persons or property.
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C.

2. Call Transportation Services within one business day to report the accident. Provide the
state vehicle’s license number, the state driver’s name, the date of accident, and who was at
fault.

3. Complete the “ACCIDENT FORM?” in the blue packet and return it to Transportation
Services with ALL OF THE FORMS listed below WITHIN 10 DAYS of the ACCIDENT.
Make sure SGS-LTER receives a copy of each form.

a. POLICE REPORT: Include one clean, legible copy of the INVESTIGATOR’S TRAFFIC
ACCIDENT REPORT from the police department that investigated the accident. (It is the
driver’s responsibility to acquire a police report. Please do not expect the accident section
of Transportation Services to acquire the report for you. )

b. RISK MANAGEMENT VEHICLE ACCIDENT REPORT (#DRM-01): This form is
found in the state driver’s VEHICLE PACKET. (Additional forms can be requested
through the accident section personnel.) Please complete each section of the accident report
as precisely as possible and make sure every copy is legible. If the information on the other
driver is missing, the state driver has a responsibility to acquire this information. Send the
white and yellow copies to RISK MANAGEMENT. Send the pink copy to Transportation
Services and keep the golden rod copy for your records.

c. The state driver must have their signature as well as their supervisor’s on the accident
report before sending to Transportation Services.

d. Please be sure to write in the license number in the upper right hand corner. If the license
number is not visible, it will hinder authorization of the body repairs of your vehicle.

4. REPAIR ESTIMATES WILL BE DONE BY TRANSPORTATION SERVICES. DO NOT
go to an insurance company to have an estimate done.

EVEN THOUGH THE ACCIDENT IS MINOR AND THE STATE DRIVER DOES NOT SEE
ANY DAMAGE, AN ESTIMATE IS STILL REQUIRED.

STATE LAW REQUIRES THE STATE DRIVER TO FILE THIS FORM WITHIN TEN
DAYS IF THERE IS INJURY/DEATH, OR DAMAGE EXCEEDS $1,000. FAILURE TO
REPORT MAY CAUSE SUSPENSION OF DRIVER’S LICENSE.

PLEASE WRITE “THE STATE OF COLORADO IS SUBJECT TO GOVERNMENTAL
IMMUNITY ACT, SECTION 24-10-101. IN ADDITION, THE STATE OF COLORADO IS
SELF-INSURED PURSUANT 24-30-1501" on the accident form.

OBTAINING AUTHORIZATION FOR:

1. Body repairs: Once the completed “accident form” is received by the accident section of
Transportation Services, the accident personnel will call the state driver or SGS-LTER to set up
an appointment to bring the vehicle to Transportation Services for estimates.

2. For back glass, door glass, vent glass, rearview mirrors (inside and outside), windshields
broken by vandals or tires slashed by vandals, this damage is not considered usual wear and
tear. The state driver must call Transportation Maintenance Assistance to set up an appointment
for the vehicle to be dropped off for glass repairs. The glass and/or tires will be authorized
provided the state driver faxes or sends the photocopy of the accident report (DRM-01) at a later
time.

3. Mechanical repairs (accident damage such as running over something causing a hole in oil
pan, gas tank, etc.) follow the body work instructions for accident mechanical repairs.
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Vehicle reservation

Please be aware that we are managing these vehicles for the benefit of the entire SGS-LTER community.
While we will do everything we can to protect reservations, we reserve the right to reassign a vehicle if an
emergency situation arises. We know that any such actions by us will create problems for researchers, and
will make every attempt to not alter reservations. Please remember that these are not your personal vehicles
and that their use is a privilege, not a right. We are expecting you to behave in a professional manner, treat
the vehicles well, keep them clean, promptly report mechanical or other problems, use vehicles during the
time you reserved them, or promptly release vehicles you may have previously reserved when you have a
change in your research plans. We are expecting you to share these resources or coordinate trips when
possible so that no one has to walk to their research sites. Misuse of vehicles, unprofessional behavior or
abuse of the system will result in loss of privileges.

From the SGS-LTER webpage:

Go to the Vehicle Reservations page: http://www.sgslter.colostate.edu/vehicle_reservations.aspx. In the ‘View
the Full Calendar’ section, follow the directions to determine which vehicles have already been committed. Use
the single arrows on either side of the top of the calendar to move to other months. This calendar is to be used
to check availability of vehicles.

You must submit a reservation request to secure a vehicle. Reservation requests must be made at least
two working days ahead of the desired date. To make a vehicle reservation, return to the Vehicle
Reservations page http://www.sgslter.colostate.edu/vehicle_reservations.aspx, scroll down to the ‘Reserve your
Vehicle’ section and enter the information requested. Click the ‘submit’ button to request your reservation.
This will send your information to Mark Lindquist and Sallie Sprague, who will add the reservation to the
calendar. Requests are generally handled within two hours (during weekdays). You will be notified by email to
confirm your reservation. (Please remember that Sallie’s normal business hours are 9 am — 3 pm.)

Travel outside of Colorado

Travel to other states must be approved by SGS-LTER. The vehicle’s fuel card is good throughout the country;
however, you should verify the card’s acceptance prior to the sale when at an unfamiliar vendor. Wyoming,
Kansas and Nebraska are out-of-state!

Road policies

Central Plains Experimental Range (CPER)
The USDA-Agricultural Research Service (ARS) Central Plains Experimental Range (CPER) has an extensive
70-year history of rangeland research directed at understanding how land management and grazing practices
affect above- and below-ground responses in the shortgrass steppe. Currently, there are over 57 ongoing
experiments at the CPER. This number of studies, coupled with the need to protect the integrity of the CPER
land area for current and future research needs, necessitates that all persons utilizing the CPER assist in efforts
to protect the rangeland resource at the CPER. Therefore, we are requesting that all persons utilizing CPER:
1) refrain from driving any vehicle off of established roads,
2) adhere to the gate policy of closing a gate behind you if it was closed when you arrived

(open gates can remain open), and
3) please help us keep the CPER clean by picking up litter/trash whenever possible and properly disposing of it.
Established roads are characterized by the complete lack of vegetation in the wheel tracks. A current map of the
established roads can be found on the SGS LTER website map page: http://sgslter.colostate.edu/maps.aspx.
When working in an area, vehicles should be parked immediately adjacent and parallel to the established road to
facilitate travel on the road by other personnel. When turning a vehicle around, please back up until
perpendicular to the road and then proceed forward to the road. In all cases, please minimize the area that is
disturbed when turning vehicles around. To prevent degradation of established roads during wet conditions,
please refrain from driving on roads unless travel is deemed absolutely necessary; if travel is warranted under

20


http://www.sgslter.colostate.edu/vehicle_reservations.aspx
http://www.sgslter.colostate.edu/vehicle_reservations.aspx
http://sgslter.colostate.edu/maps.aspx

these conditions, please use slow speeds to prevent splashing from puddles in the road. Roads with vegetation in
the wheel tracks are defined as 1) those that have been abandoned and are in the process of healing or 2) those
which have been created without authorization; please refrain from driving a vehicle on these roads. If off-road
travel is truly warranted for one-time sampling or other endeavors, the person(s) must request permission from
Mary Ashby (Station Manager, CPER, 970-897-2226, or Mary.Ashby@ars.usda.gov) prior to any off-road
driving. Failure to adhere to this policy will result in a written warning to the person(s) and his/her supervisor(s)
for first time violation, and subsequent violations may result in the loss of use of CPER for the person(s). If you
have any questions pertaining to this road policy at CPER, please contact the Scientist-in-Charge of CPER,
Justin Derner, at 307-772-2433 x. 113, or Justin.Derner@ars.usda.gov.

Pawnee National Grassland (greater PNG)

The Pawnee National Grassland has established motor vehicle travel controls in order to enable safe motorized
travel while also protecting natural resources and minimizing conflicts with non-motorized uses. Specific rules
are implemented by order of the Forest Supervisor and are available at the District Ranger’s Office. A network
of numbered roads will take you within easy walking distance to almost all parts of the Grassland. Travel by
motorized vehicles is authorized only on constructed roads, two-track roads, and specific areas designated for
travel. Travel by motorized vehicles is not authorized on roads signed as “Administrative Use Only” or
“Closed”. Motorized vehicles must comply with State law. Open roads are marked by a sign with a Forest
Service shield and road number. To protect prairie vegetation and avoid soil erosion, motorized travel cross-
country is prohibited unless authorized in writing by the District Ranger. Another exception is for over-snow
travel by snowmobile. Cross-country hiking and horse travel is permitted and is an excellent way to enjoy the
prairie. Free motor vehicle us maps for the Pawnee are available at the PNG Office at 660 O Street in
Greeley, or on the web at www.fs.fed.us/r2/arnf or from the SGS LTER website map page
http://sgslter.colostate.edu/maps.aspx.

Direct motorized vehicle access is authorized to suitable parking sites within 300 feet of an open road for
recreation activities such as camping, picnicking, bird-watching, or hunting.

Some roads are closed temporarily in the spring and early summer to minimize soil disturbance and protect
wildlife habitat. Contact the District Rangers’ Office for information on these closures.

Mountain bike riding is becoming a very popular activity on the Grassland. The best routes are two-track roads
and constructed roads. Cross-country travel is not recommended, because tires may be punctured by cactus
spines.

The majority of the Pawnee’s roads can be traveled by high clearance vehicles. Sedans can travel many of the
roads during dry conditions but are not suitable on rougher roads. Most Forest Service roads are not graveled.
Many of the arroyos do not have bridges or culverts. Travel on wet un-graveled roads is discouraged, both for
your own safety and to prevent damage to the road. Return to a graveled road if storms threaten. During heavy
rains, even graveled roads can be impassable.

Field Safety
Medical dangers and precautions

Prairie rattlesnakes are abundant; watch where you walk and listen for their characteristic rattle.

Poisonous spiders include the Black Widow (identified by a red hour-glass shape on a shiny black body) and
the Brown Recluse (identified by a brown fiddle shape on a lighter brown body). Do not reach into small and/or
dark spaces (e.g. pitfall traps) without protective tools or gloves.

Heat exhaustion/stroke can be prevented by drinking plenty of water, wearing light-colored clothing, and
wearing a hat.

Sun burns are common. Bring sunscreen and a hat for yourself.
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Infected wounds can occur from abrasions, lacerations, and punctures that go untreated. Barbed wire cuts can
easily become infected even when the wound seems small and insignificant. Band-Aids and disinfectants are
good items to keep with you. You may want to consider getting a tetanus shot if you haven’t had one recently
(consult physician).

West Nile Virus can be carried by birds and transmitted to humans by mosquitoes. If you are going to be
working near wet areas or during dawn and dusk when mosquitoes are most active, wear bug repellent (DEET)
and cover exposed skin to prevent bites. Check CDC guidelines for additional information.

Hanta Virus can be carried by the deer mouse and can be transmitted to humans who come in contact with deer
mouse feces. If you will be working with deer mice or in areas where feces may be present (garages, barns),
you may want to take precautions recommended by CDC.

Bubonic Plague can be carried by prairie dogs and fleas. If you will be working with prairie dogs, you may
want to take precautions recommended by CDC.

Thunderstorm safety

The weather may change very rapidly; lightening, hail, tornados and snowstorms are all possible. If you are
outdoors:

Attempt to get into a building or a hardtop car and keep the windows closed.

If no structure is available, go to an open space and squat low to the ground.

Avoid tall structures, such as towers, tall trees, power and telephone poles, and equipment that might
function as a natural lightening rod, such as backhoes, soil augers, weather stations, etc.

If you are isolated in a level field and feel your hair stand on end (which indicates lightening is about to
strike) drop to you knees and bend forward, putting your hands on your knees. Do not lie flat on the
ground!

If you are in a vehicle:

Pull safely onto the shoulder of the road; turn on emergency flashers.
If flash flooding is possible, go to higher ground.

If you are indoors:

Secure outdoor objects that could blow away and cause property or personal injury.

Do not handle any electrical equipment or telephones, as lightening can follow wiring.

Listen to a battery-operated radio.

Do not take a bath or shower, as metal pipes can transmit electricity.

Turn off computers and other items that can be damaged by lightening-induced power surges.

What to do in an emergency

It is advisable to have a cell phone with you at all times. Use 911. The address of the LTER (North Side) Field
Station is 14791 Weld County Road 114, approximately 3/4 mile east of the intersection of HWY 85 and CR
114. The address for the Shortgrass Steppe Research and Interpretive Center (South Side) is 14698 Weld County
Road 114, approximately 3/4 mile east of the intersection of HWY 85 and CR 114. The address of the ARS field
station is 58009 Weld County Road 37, approximately 2 miles north of the intersection of CR 114 and CR 37.

Keep maps with you at all times and be able to communicate your location with emergency responders.
If you see behavior on the PNG, the CPER or adjacent private land that may be dangerous to
people/livestock/wildlife or damaging to personal property, please note date, time, location,
license/tag number, vehicle description or other details, and report the activity to the
appropriate law enforcement official and/or the ARS or PNG offices.
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Emergency Numbers:

911

SGS-LTER (North Side) Field Station — 970-897-2210
Mark Lindquist cell phone — 970-213-9576

ARS Field Station — 979-897-2226

USFS PNG Field Office — 970-353-5004

DOW Game Warden (Troy Florian): 970-356-2753
Colorado State Patrol — 303-239-4501

Weld County Sheriff — 970-356-4015

Other Emergency Numbers:

Fort Collins Police — 970-221-6540

Larimer County Sheriff — 970-686-7439

Road and Weather Conditions — 970-356-7420

Poison Control — 1-800-332-3073

Arson Hotline — 0 + 892-7766

West Ridge Animal Hospital (certified animal rehab): 970-330-7283

Local Hospitals:

North Colorado Medical Center Poudre Valley Hospital
1801 16th St. 1024 S. Lemay
Greeley, Colorado Fort Collins, Colorado
Emergency Room — 970-350-6244 970-495-7000

Hospital — 970-972-4121

Recommended First Aid Kit Contents:

Red Cross CPR Pocket Mask  Ibuprofen 4X4 Bandages
Alcohol Wipes Imodium AD Roller Bandages
Antibacterial Ointment Pepto Bismol Assorted Band Aids
Betadine Snake Bite Kit Occlusive Bandages
Benadryl Slings Tweezers

Bug Repellant Sunscreen Scissors

Rubber Gloves

And any personal medicines you may need on a regular or emergency basis.

There is a first aid kit in the lab at the North Side headquarters building.
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